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Abstract

As emerging marine technologies lead to the development of new infrastructure across the
ocean, they enter an environment that existing ecosystems and industries already rely on.
Although necessary to provide sustainable sources of energy and food, careful planning will
be important to make informed decisions and avoid conflicts. This paper examines several
techniques used for marine spatial planning, an approach for analyzing and planning the use
of marine resources. Using open-source software including QGIS and Python, the potential
for developing offshore aquaculture farms powered by a reference model wave energy con-
verter from the Sandia National Labs, the RM3, along the Northeast coast of the United
States is assessed and several feasible sites are identified. The optimal site, located at 43.7°N
68.9°W along the coast of Maine, has a total cost for a 5-pen farm of $56.8M, annual fish
yield of 676 tonnes, and a levelized cost of fish of $9.23 per kilogram. Overall trends indicate
that the cost greatly decreases with distance to shore due to the greater availability of wave
energy and that conflicts and environmental constraints significantly limit the number of
feasible sites in this region.

Keywords: marine spatial planning, fisheries, offshore aquaculture, wave energy, gis,
python

1. Introduction

Oceans have long been a source of opportunity, and conflict, for the communities and
industries along their shores. This rich environment, first used as a source of food and for
recreation, has since been utilized by other offshore activities including mineral extraction,
shipping, aquaculture, and most recently, offshore renewable energy (ORE) systems. Even
before the expansion of renewable energy, interactions between different industries led to
challenging situations between fisheries and other stakeholders with varying degrees of res-
olution. Arbo and Thiy (2016), for example, researched disputes between the oil industry
and fisheries in Norway and Vietnam. In Norway, the two industries were able to reach a
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common agreement to collaborate and work together with an integrated management plan
in the Barents Sea, while in Vietnam the two industries have continued to face challenging
conflicts. Another study by Andrews et al. (2021) examined the offshore oil industry’s ad-
verse impacts on the environment, small-scale fisheries, and coastal community livelihood.
Conflicts involving fisheries are further complicated by uncontrolled fishing activities and
overlap between recreational and commercial fisheries, which threaten fish stocks and the
overall health of the ocean (Bess and Rallapudi, 2007).

Entering this mix is the emerging industry of offshore aquaculture, which has the potential
to provide a more sustainable and protein-rich source of food for the growing population
(NOAA Fisheries, 2023). Compared to conventional aquaculture, offshore aquaculture farms
raise fish in the open ocean instead of sheltered bays or onshore tanks. Existing literature by
researchers including Gentry et al. (2017), Weiss et al. (2018), Brugere (2006), and Bishwajit
(2014) has brought to light challenges and opportunities for aquaculture farms, including
the potential for significant expansion in many parts of the world including Southeast Asia,
Australia, North America, and South America. Many of these studies, and particularly
Longdill et al. (2008), look specifically at the impact on the local environment and how
different environmental factors and the siting of farms can change the effects of pollution
and other negative disturbances. However, few consider the energy source of the farm, which
is often diesel generators, and the potential ways to mitigate the environmental impacts of
the associated fossil fuel use.

High ORE growth in response to climate change has created new challenges for many
fisheries that currently use the same waters. Stelzenmiiller et al. (2022), studied the impacts
of ORE development in the North Sea and the socioeconomic effects on fisheries in that
region. Although they find that conflicts exist currently and are ongoing, they predict
increasing friction between fisheries and ORE activities after 2025. Some work does show
promising signs for the collaboration between existing fisheries and the expanding ORE
industry, particularly when coastal communities are brought into the planning process early
on. The Block Island Wind Farm, for example, was able to work with local communities
and fisheries and decided to change certain plans, including the placement of the turbines,
in response to community input (Firestone et al., 2020; ten Brink and Dalton, 2018).

The opportunity to co-locate offshore activities together is another promising solution for
managing the increasingly congested ocean. Two industries with the potential for co-location
are ORE systems and offshore aquaculture farms, where an ORE system can power the farm
and potentially shield it from incoming waves. Several studies exist discussing the feasibility
of co-locating offshore wind farms to make more efficient use of ocean space including Buck
et al. (2004), Buck et al. (2008), Gimpel et al. (2015), and Wever et al. (2015). Co-location
with wave energy converters (WECSs) to form a wave-powered aquaculture farm (WPAF) is
a particularly interesting option that may be a better match due to a WEC’s smaller size
and power output, which is closer in scale to the needs of an aquaculture farm. In Garavelli
et al. (2022), the authors analyzed the feasibility of this co-location in the United States and
identified California and Hawaii as promising sites for future deployment. Co-located WPAFs
have also been investigated along the Portuguese coastline, where six different types of WECs
have been compared in terms of cost, energy coverage, and capacity factor (Clemente et al.,
2023). Whiting et al. (2023) and Silva et al. (2018) have also investigated the near and
far-field effects of wave energy which has the potential to dampen waves as they approach



an aquaculture farm, although this is still an area of active research.

Previous work by the authors of this paper has developed the groundwork for basic con-
ceptual design and optimization of a WPAF (Hasankhani et al., 2023a) and initial attempts
to site such a project in the Northeast United States (Hasankhani et al., 2023b). However,
a comprehensive framework for marine spatial planning (MSP) using QGIS and Python,
specifically one that considers conflicts with other offshore activities and the environmental
and geographic requirements for a WPAF, has yet to be detailed. This paper provides a de-
tailed and general framework for the preprocessing and analysis needed for MSP, and applies
those techniques alongside an updated cost model to the question of offshore aquaculture
siting.

Using these techniques, the authors of this paper aim to assess the potential to integrate
wave power into the farm setup, analyze the potential conflicts and environmental constraints
that such a farm might face, and provide suggestions for the development of such a farm
in the Northeast United States. The farm is modeled using Atlantic salmon, the reference
model three (RM3) WEC, and submersible net pens like those from Innovasea, as explained
in section 2. By beginning with large-scale mapping techniques, promising sites in the region
of interest are identified, and details of the overall considerations that must be made when co-
locating wave energy converters and aquaculture farms are revealed. Further integration with
Python allows GIS information to be used in a more complex modeling process that includes
an objective function to identify cost-effective sites while meeting several constraints. These
techniques exemplify the ways that GIS information and modeling could be integrated into
a wide range of MSP processes to improve the understanding of the oceanic environment,
pick out overall trends relevant to a project, and initiate early engagement with stakeholders
to avoid or mitigate potential issues.

Each section of the paper aims to present general information about the MSP process
in addition to the specific ways that these methods are applied to the case study of a
WPAF. Section 2 provides a brief overview of the problem formulation for the application
of MSP techniques to a WPAF in the Northeast United States. Section 3 continues with
considerations for selecting a scope and data sets for a problem, followed by sections 4 and 5
which detail the methods used in both Python and QGIS to process the data sets and model
different potential WPAF sites. Finally, sections 6 and 7 present the results and discuss
observed trends. The Python code referenced in this paper is available in a repository on the
SEA Lab GitHub at https://github.com/symbiotic-engineering /aquaculture and the relevant
data files are hosted on Zenodo at https://zenodo.org/records/10140826.

2. Problem formulation

The MSP techniques examined in this paper can be used for a variety of purposes, such
as the siting of offshore energy infrastructure and identifying potential conflicts between
stakeholders. These techniques are potentially applicable to a wide array of offshore devel-
opments, but the specific application of MSP to a WPAF in the Northeast United States is
the focus on this study. Figure 1 provides an overview of the process used for this study and
other potential applications.

Offshore aquaculture has the potential to provide a sustainable source of seafood for the
world’s growing population. By taking advantage of more space and higher current speeds
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Figure 1: Flowchart describing the marine spatial planning process used, including selecting the scope and
data, preprocessing data sets, analysis in both QGIS and Python, and visualizing results.

further from shore, offshore farms could reduce local environmental impact and expand
production. However, the energy demand for necessary equipment like lights and feeders
in current designs is supplied by diesel generators. This fossil fuel based source of power
further pollutes the environment and requires a regular diesel supply from shore. The use
of WECs alongside aquaculture farms has the potential to replace diesel generators and
alleviate some of these issues, although many of the local environmental concerns still need
to be addressed. In order to investigate this potential co-location, the following points are
considered to identify optimal sites in the Northeast United states:

e the deployment location should meet the environmental requirements of Atlantic salmon
including temperature, salinity, dissolved oxygen, and current speed;

e the deployment location should have enough wave power density to power the aquacul-
ture farm, as determined by data on significant wave height and wave energy period;

e the WPAF should be installed in a location with a suitable depth for mooring necessary
equipment;

e the WPAF should avoid conflicts with existing offshore activities such as commercial
fisheries and wind lease areas; and

e feasible sites should be evaluated for location-dependent costs to minimize the cost of

the WPAF.

The modeled WPAF includes five cylindrical net pens of 30 m diameter and 15 m height,
each with a fish stocking density of 15 %. The net pen design is similar to those designed by
Innovasea, and will be stocked with Atlantic salmon, a common and in-demand species with
similar biological needs to steelhead trout, as the target species. The WECs used to power
the farm will be the Reference Model 3 (RM3) as designed by Sandia National Laboratories.
The RM3 WEC is a two-body heaving point absorber with a top float that moves relative to
a vertical column and reaction place when excited by waves. This mechanical energy from
ocean waves is converted into electrical energy through a power take-off (PTO) system and
a generator within the WEC. The RM3 has a height of 30 m, float diameter of 20m, and a
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(a) RM3 WEC (b) Innovasea submersible net pen

Figure 2: Reference model 3 (RM3) wave energy converter (Neary et al., 2014), and Innovasea submersible
net pen considered in this study (Innovasea, 2023).

rated capacity of 286 kW (Neary et al., 2014). Per discussion with aquaculture stakeholders,
a spacing of 150 m between the net pens is considered to provide enough space for the
mooring and vessel operation. Additionally, the spacing between WECs is considered twice
the WEC diameter to avoid any destructive wave interaction and reduction in the generated
power (Zhong and Yeung, 2019). Two feed barges are also required to enable automatic fish
feeding; each barge has six feed lines and a capacity of 200 metric tons (Scale Aquaculture
AS, 2019). Travel to the net pens using ships is scheduled weekly to restock the feed barges
and check the aquaculture farm.

3. Scope and data selection

3.1. Study scope

This study focuses on waters along the Atlantic coast of the Northeastern United States.
The region is home to several large fisheries, and the industry holds important historical
and cultural significance in the area. Overfishing and environmental changes over the past
decades, however, have greatly diminished fish stocks leading to record lows in annual catches
of cod and other species (Whittle, 2022). The region is also home to several aquaculture
operations, although the authors are not aware of any currently located far offshore as
suggested in this study. Northeast Sea Grant defines the Northeast as the states of Maine,
New Hampshire, Massachusetts, Rhode Island, Connecticut, and New York (Northeast Sea
Grant, 2022), which are therefore the main focus of this study. However, to include all
regions that are easily accessible from ports in these states, this study uses a slightly larger
scope which also includes Delaware and New Jersey. The study includes both state waters,
within 5.6km (3 nautical miles) of shore, and federal waters, within 370km (200 nautical
miles) of shore, as shown in figure 3. This region is roughly bounded by 38.40°N 75.80°W
and 45.20°N 65.70°W.

There are several approaches to evaluating complex models across a large region, de-
pending on the needs of a project. Projects aiming to identify individual optimal sites may
benefit from optimization techniques such as gradient descent that search for locations that
minimize an objective function such as cost. For this study, however, a brute-force approach
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Figure 3: Selected region of Northeastern United States including state and federal waters, along with the
0.1° grid of sampled points (points over land are excluded early in analysis).

is used to allow the entire region to be evaluated so that overall trends can easily be iden-
tified. Unlike an optimization approach which strategically searches for a minimum, the
brute-force approach evaluates every location at a set interval across the region. Although
more time-consuming, the results of this approach provides a more complete understanding
of the entire region. The results using this approach are achieved in a reasonable time frame,
under an hour, for the current model, however a more complex model may necessitate a
different approach to optimization. The interval at which sites are evaluated with this ap-
proach determines the “resolution” of the results, which is limited by how much processing
time is practical and the lowest resolution of the data sets used in the study. Some common
properties like bathymetry have very high-resolution data sets available, while others may
be lower resolution or limited to smaller areas. For this study, a resolution of 0.1° longitude
and latitude (roughly 10km in this region) is selected to balance the need for precision while
not being overly demanding of computational time. This is slightly lower than the most
limiting data sets of wave conditions, which have a resolution of about 0.067°. Figure 3
shows the points sampled at this resolution alongside the state and federal waters included
in the study scope. While this resolution provides general trends across the entire region, a
higher resolution pass would be necessary for later stages of planning, especially once a more
specific region of interest can be identified. Table 1 includes the resolution of individual data



files, which indicate the highest resolution that could be achieved before other data sources
become necessary.

3.2. Sources of data

GIS data types fall into two general types: raster and vector data sets. Raster data sets
provide pixels of continuous information like physical conditions or satellite imagery, while
vector data sets describe points, lines, or areas. In this study, raster data sets are used
for oceanic conditions and bathymetry, while vector data sets describe regions of potential
conflict and administrative boundaries. Current speed, dissolved oxygen, temperature, and
salinity are used to determine the carrying capacity. Significant wave height and wave energy
period are used to determine the wave power potential, which along with distance to port is
used in the cost model. Bathymetry data, regions with other active industries, and restricted
areas are used to constrain the feasible area. Together, these data sets are used to evaluate
the location-dependent costs for each site and identify potential conflicts, as discussed in
sections 5.2 and 5.3.

The data in this case study is sourced from several organizations that have publicly
available GIS data including the Bureau of Ocean Energy Management (BOEM), the Na-
tional Oceanic and Atmospheric Administration (NOAA), the National Renewable Energy
Lab (NREL), the Northeast Ocean Data Portal (NODP), and the United States Cen-
sus. Tables 1 and 2 contain an overview of the information used in the case study in-
cluding the data type and file source. Section 4.1 explains the steps taken to standard-
ize these different data sets which includes file conversion, interpolation, clipping, and
re-projection. Preprocessed versions of each of these data sets are hosted on Zenodo at
https://zenodo.org/records/10140826.

It is important to select data that is a good fit for the study, especially when multiple
sources are available. With significant wave height and wave period, for example, an older
raster data set of annual averages from NREL is chosen because it provides continuous
information across the region and is available in a format that is readily compatible with
GIS. NOAA’s National Data Buoy Center, another possible option, could have provided
the same information but would have limited the analysis to the few locations where buoys
already exist and would have required more processing to integrate into the model. In other
cases, available data sets may be limited by resolution or region. An older bathymetry data
set, for example, is selected because it provides a high resolution across the entire study
scope while more recent surveys are limited to a smaller region.

3.8. Software selection

Software is selected for this work with the intention of being accessible to a wide range of
applications and users who might benefit from MSP. As a result, only open-source software is
used in the final process. GIS software is used for basic processing and visualization of results
including the layout of published maps. QGIS is used as the main GIS software because of its
widespread availability and complete set of processing tools. QGIS unfortunately lacks the
ability to process certain proprietary data types from ArcGIS, the current industry standard,
but is otherwise a capable and free option. Python, along with the GeoPandas package, is
used to handle more complex modeling such as the carrying capacity and cost functions
which would be difficult in GIS software alone. For these cases, a Python package is created
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Table 1: Raster data sets that are included in the study, including those relating to environmental conditions,
wave energy potential, bathymetry, and distance to port. Source and approximate resolution are also noted.

Name Unit Notes Source
Current speed m/s Finite volume community Northeast Ocean Data Portal
ocean model (FVCOM) and Shmookler (2016)
annual climatology, 0.002°
resolution downsampled to
0.004°
Dissolved oxygen mg/L Annual climatology, National Centers for
interpolated from vector data Environmental Information
with 1° resolution to a raster (2019)
with 0.015° resolution
Salinity PSU Annual climatology, National Centers for
interpolated from vector data Environmental Information
with an irregular but roughly (2019)
0.1° resolution to a raster
with 0.01° resolution
Temperature °C FVCOM annual climatology, | Northeast Ocean Data Portal
0.002° resolution and Shmookler (2016)
Wave height m 51-month Wavewatch III National Renewable Energy
hindcast, 0.067° resolution Laboratory (2011)
Wave period S 51-month Wavewatch IIT National Renewable Energy
hindcast, 0.067° resolution Laboratory (2011)
Bathymetry m 0.0007° resolution, National Geophysical Data
downsampled to 0.003° Center (1990)
Distance to port m 0.005°vector generated from Office for Coastal
vector of principal ports Management (2019)

Table 2: Vector data sets that are included in the study, including those relating to conflicting industries,
restricted areas, and administrative boundaries.

Name

Notes

Source

Fishing traffic

automatic identification system

Generated using raster from

(AIS) transponders

Fontenault (2022)

Marine protected areas

National Marine Protected
Areas Center (2020)

Military zones

Includes danger zones, restricted

areas, submarine transit lanes,
and testing areas

Northeast Ocean Data Portal
et al. (2016); Office for Coastal
Management (2022)

Offshore wind

Includes wind leases, planning
areas, and existing farms

Northeast Ocean Data Portal
(2015); Bureau of Ocean Energy
Management (2023); Northeast

Ocean Data Portal (2010)

Shipping lanes

Office of Coast Survey (2015)

State, federal waters

Office for Coastal Management
(2018)

USA major cities

ESRI (2023)




to interface between the main model and the individual GIS data sets, as demonstrated in
section 5.

4. QGIS processing and analysis

4.1. Preprocessing data

Several preprocessing steps are necessary to standardize downloaded GIS data files and
prepare them for further mapping and analysis. These include occasional file conversion to
a QGIS-compatible format, vector interpolation for environmental conditions, clipping data
sets to the study scope, and reprojection to either WGS 84 or WGS 84 / UTM Zone 19.
More thorough instructions to complete these steps in QGIS are provided in Appendix A.

4.2. Raster analysis

Although most analysis for this case study is done within the Python model shown in
section 5, there are several helpful functions in QGIS that can aid in understanding and
visualizing the data. For this study, two are used: generating contours to display the range
of oceanic conditions, and highlighting regions that meet certain conditions or constraints
with Raster Calculator. Figure 4 shows all raster data sets used in the case study, including
environmental conditions used to identify favorable conditions for a certain species, average
wave period and height to estimate WEC power output, and bathymetry and distance to
port which further constrain feasible sites and affect the cost. The environmental conditions
are also used to evaluate the carrying capacity of a location, which indicates how large a
population can be sustained in a given environment. Generating contours and using the
Raster Calculator in QGIS are both discussed in Appendix A.

4.3. Vector analysis

In this study vector data is used to represent conflicts, which QGIS can aid in identifying.
It is often helpful to convert between raster and vector formats depending on the analysis
needed. Areas with high fishing vessel traffic, for example, are excluded in this analysis and
so a vector of regions that have high fishing traffic is first created using the raster input data.
Vector data sets are the core of the conflict analysis used to identify overlapping industries,
and each of the included data sets are pictured in figure 5.

Like raster files, vector data sets are later loaded into Python, but preliminary maps of
conflicts can also be generated in QGIS to identify and highlight potential issues early on.
Figure 6 demonstrates this technique using the data sets for wind lease areas and regions of
high fishing traffic, and highlights the regions where these industries overlap and therefore
could conflict. Note that although the regions highlighted in figure 6 include areas that
had above-average fishing traffic in 2021, only areas with very high fishing traffic (over one
standard deviation above the average) are considered infeasible farm locations in the Python
model. This conclusion was determined after attending meetings hosted by the Bureau of
Ocean Energy Management with stakeholders in the fishing and offshore wind industries.
The fishing community is very protective of their fishing grounds and information about
where they are is limited. Therefore, this assumption reflects a reasonable understanding of
potential conflicts with fisheries and other industries.
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Figure 4: Raster data sets of conditions considered in the analysis with generated contours overlaid. Envi-
ronmental conditions and bathymetry are used to identify feasible sites, while the wave climate and distance
to port are used in the cost model.

5. Python integration and modeling

5.1. GIS-Python interface

Although QGIS is a powerful tool for the analysis and visualization of geospatial data,
some functions like modeling and optimization are difficult in QGIS alone. For this reason,
Python is used as an intermediary step for more complex analysis. Figure 7 shows the overall
process for using both approaches where the Python optimization tool uses a “handler” object
to query geospatial data processed in QGIS to evaluate the location-dependent costs of the
farm. This handler and examples of its usage are available on the SEA Lab GitHub at
https://github.com/symbiotic-engineering /aquaculture.

After completing the basic preprocessing described in 4.1, GeoPandas, Shapely, and
Rasterio packages are used to process geospatial data in Python. First, a custom "handler"
object is created in Python to handle the integration of the geospatial data sets with the
Python model, which expects simple numerical values for conditions and flags for when
there are potential conflicts. The handler first constructs a GeoPandas GeoDataFrame,
which stores data and the results from the Python model in a format that can later be read
again by QGIS. Conflict vectors are also loaded as separate GeoDataFrames, while condition
rasters are loaded using Rasterio.
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Figure 5: Data sets for all regions with conflicting industries or restricted areas that are excluded from the
analysis, including shipping lanes, marine protected areas, and more.

The handler allows the model to query individual points by latitude and longitude and
passes along the value at that point for each loaded condition raster. It then flags the
point if overlaps with any of the vectors that have been loaded. One flag is used to identify
conflicts, another is used to indicate whether the point queried is out of the study scope, and
a third is used if all raster condition data sets exist at the given point. The handler then
receives the result for a given point from the cost model and stores it in a GeoDataFrame.
Although individual queries are helpful for an optimization approach, the handler can also
query information for many points at once to fully populate a grid of potential sites. Finally,
the GeoDataFrame with the model result is exported again as a GeoJSON file that can be
loaded into QGIS to create final maps of the results.

5.2. Cost model

The cost model evaluates the costs associated with development of a WPAF at a given
site, and is modeled entirely in Python. A brief explanation of the cost model as relevant to
the WPAF case study is included here, but details about this function and the optimization
process can be found in a previous paper by this author, Hasankhani et al. (2023b). In
this study, the objective is to minimize the location-dependent cost of the WPAF, and the
design variable is the WPAF deployment location which determines the environmental and
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geographic conditions used as inputs in the model.

The two WPAF cost terms that are the most dependent on the deployment location
include the cost of the WECs and the cost of vessel travel associated with weekly trips to
check the farm and restock the automatic feeders. The cost of WECs is determined by the
availability of wave energy at a location and, from that, the number of RM3 WECs necessary
to power a farm of a given size. The energy yield of the WEC is calculated considering the
wave power density of the WPAF site and the capture width, which is the ratio of the power
absorbed by the WEC to the wave power density of the site. This capture width is defined
as the product of the physical dimension of the WEC and the hydrodynamic efficiency of
the WEC, known as the capture width ratio. The capture width for an array of WECs is
considered to be the sum of each individual WEC’s capture width for this analysis. The wave
power is found through the annual average of the significant wave height and wave period, as
discussed in section 3.2. The model does not take into account the layout, direction, or near
and far-field effects of the WECs and pens. Vessel travel cost to the WPAF is the second
operating expense which increases for deployment locations further from the coast due to
higher travel costs. This vessel travel cost is defined by the necessary travel time multiplied
by the cost of labor and fuel. Though the total cost of the WPAF system depends on
additional factors such as net pen design cost, feed barge cost, fish feed cost, and fingerling
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Figure 7: The analysis process between QGIS and Python for the marine spatial planning process.

cost, these remain constant for a designated size of aquaculture farm (e.g. five cylindrical net
pens measuring 15 m in height and 30 m in diameter). These constant costs are therefore not
modeled in this case study, but are the subject of future work. The location-dependent costs
are modeled over the total lifetime of the project, including capital expenditures (CapEx) and
operating expenses (OpEx). The objective function and total cost formulation is presented
in equations 1 and 2 where r = 0.07 is the discount rate (FEMP, 2021) and ¢ reaches the
expected lifetime of 15 years.

min total costwgc + total costyessel travel (1)
location

15

OpE
total cost = CapEx + Z ( PEX
t=1

oy 2

The CapEx and OpEx terms for WECs are defined by multiplying the number of WECs
required to power the farm of a set size by the reference CapEx and OpEx of each RM3 WEC.
These reference CapEx and OpEx for the RM3 are determined considering the economies of
scale as detailed in (Neary et al., 2014). Values for costs that are not location-dependent are
referenced in the results section in table 4. Constant capital expenditures include the net
pen and feed barge, while constant operating expenses include fish feed and the fingerlings
used to stock the farm at the beginning of each season. For this study, a harvest period of
one year is considered, where the fingerlings are put in the net pens at a weight of 200g.
Note that the cleaning costs of the net pens and feed barge are considered zero since they
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are negligible compared to the capital cost (Innovasea, 2023).

A metric like levelized cost of energy is also used to calculate the cost per fish yield of a
farm at a given site. This levelized cost of fish is calculated by dividing the total farm cost
by the discounted fish yield over the lifetime of the farm, as shown in equation 3 where r
and ¢ are the same as in equation 2.

total t
levelized cost of fish = —ro COo0 (3)

15 fish yield
t=1"(1+r)t

It should also be mentioned that the cost analysis in this study is made per an assumption
that the energy demand of the aquaculture farm is modeled as a constant annual value using
a reference value for power per fish yield reported by Freeman et al. (2022). Hence, the
energy demand is overestimated and considered constant per year, and hourly fluctuation of
the power consumption of the aquaculture farm, such as an increase in energy demand while
fish feeding, is not considered in this study. Furthermore, the uncertainty of the wave power,
(i.e. the hourly data of wave significant height and wave energy period) is not considered in
this study, and all the results are presented with the annual average wave data. Therefore,
the cost of the WPAF, and specifically the cost of WEC, could change in future studies using
high-resolution hourly data for aquaculture farm energy demand and wave power.

5.3. Constraints

The analysis assess for a variety of constraints to exclude sites that do not meet the feasi-
bility requirements for WPAF development. These constraints include ensuring that a given
site does not intersect with other offshore industries or restricted areas, that the necessary
carrying capacity for Atlantic salmon is met, and that a suitable depth and environmental
conditions within an acceptable range are present. These constraints are formulated in equa-
tions 4, 5, and 6 where C'Co, refers to the carrying capacity considering oxygen availability.

fishing vessels
shipping lanes
exclude conflicts with military zones (4)
marine protected areas
offshore wind farms

fish yield < CCo, (5)
temperature, ;. temperature temperature,,,
salinity, ., salinity salinity, .
dissolved oxygen,;, | < |dissolved oxygen| < |dissolved oxygen,,, . (6)
current speed_;, current speed current speed, .
depth,;, depth depth, .

Intersection with existing industries and protected areas is evaluated directly by the GIS
handler using the vector data sets of these regions. This information is then passed along
with the environmental conditions from the raster GIS files at a selected site to the python
model which evaluates the carrying capacity and environmental constraints alongside the
objective function of location-dependent costs.
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The carrying capacity is a measure of the amount of fish biomass that can be placed in
the aquaculture farm while maintaining a healthy environment and is in this study deter-
mined using the current speed and dissolved oxygen (Stigebrandt et al., 2004). The carrying
capacity of a row farm is formulated in equation 7 where Oy, is the average dissolved oxygen
at the deployment site, Og iy is the minimum dissolved oxygen required for the fish, Dy, is
the net pen diameter, H,c, shows the net pen height, U, is the minimum current speed, Pe
is the permeability of the farm, and DO, is the mean oxygen consumption rate per kilogram
of fish production per day.

86400(021n - OQmin)n ensD enH en(]minP6
0002 = DOI; p p (7>

Finally, the feasibility of the environmental conditions and bathymetry are evaluated for
a given site. Table 3 lists the range of acceptable values for each of these constraints. The
bathymetry constrain is set by the feasibility of mooring submersible net pens to the ocean
floor, but the connections and power distribution between the WECs, net pens, and other
equipment are not considered. The mooring requirements of the RM3 WEC of 40-100m
(Neary et al., 2014) are considered but the requirements for submersible net pens of 40-75m
are more limiting.

Table 3: Constraints for a sample offshore Atlantic salmon WPAF

Parameters Description Unit | Value Source
Tonin Minimum temperature °C 2 Pecherska (2019)
Trnax Maximum temperature °C 20 Pecherska (2019)
Samin Minimum salinity PSU 30 Pecherska (2019)
Stmax Maximum salinity PSU 35 Pecherska (2019)
O32 min Minimum dissolved oxygen | mg/L 4.41 Pecherska (2019)
O3 max Maximum dissolved oxygen | mg/L -

Upin Minimum current speed m/s 0.01 Pecherska (2019)

Umax Maximum current speed m/s 2 Pecherska (2019)

demin Minimum depth m 40 Stakeholders

démax Maximum depth m 75 Stakeholders
6. Results

In this section, the MSP results for a small WPAF with five net pens are presented.
Although the conflict analysis significantly limits the number of feasible sites, a cost term
is still initially calculated for each point in order to show overall trends, and the results are
presented in figure 8. The results of the objective function calculating location-dependent
costs across the region range from $13.1M far from shore to $4.0B in bays and sheltered
areas near the coast where wave energy production is unrealistic.

Figure 9 shows the results of imposing different constraints on the WPAF model. Given
the resolution of 0.1° latitude and longitude across this region, 7038 points are initially
sampled, of which 3249 are offshore and only 1247 have data available for every condition
in question. The number of feasible sites is further limited to 1182 feasible sites that meet
acceptable environmental conditions, 529 sites with feasible bathymetry, 825 sites with no
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Figure 8: Results for the cost function (i.e. location-dependent costs over the lifetime of the farm) on all
points with data available. Location-dependent cost is inversely correlated with distance from shore.

conflicts with industries or restricted areas, and 365 sites with sufficient carrying capacity.
Together these constraints significantly narrow the feasible region and leave only 52 feasible
sites (~4%) along the coast of Maine that meet all the requirements, as shown in figure 10.

Combining both the objective function and constraints yields several final sites that meet
the stated requirements, and one optimal site with the lowest cost. For feasible sites, the
objective function ranges from $30.0M to $3.0B and follows a similar trend as the overall
results. Feasible sites are shown in figure 10, with figure 11 providing further detail near the
optimal site. Both figures show sites color-coded by their value for levelized cost of fish. The
small numbers next to each site on the figure denote the levelized cost of fish as a multiple
of the cost of the optimal site.

The scatter plot, shown in figure 12, provides more detail on the results of the cost analysis
and overall trends. The chart compares the effects of the two location-dependent cost terms
in different subsets of the results. The diamond-shaped points show all non-dominated sites
for the overall cost function without respect to constraints (figure 8) while the circular points
show all sites that meet the constraints (figure 10). For each of these sets, a Pareto front
and utopia point is shown, and the overall cost function is indicated by the color gradient.
The utopia point refers the hypothetical ideal point that exists at the optimal values for
each objective. The figure shows the dominance of WEC cost in the overall cost function as
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Figure 9: Potential sites with data available are evaluated for constraints including acceptable environmental
conditions, feasible bathymetry, no conflicts, and sufficient carrying capacity.

the cheapest sites overall occur low on the WEC cost axis but vary only slightly with their
position on the travel cost axis. The difference between feasible and overall non-dominated
sites is also interesting. The cheapest feasible sites approach the overall Pareto front but fail
to compete with the absolute cheapest sites because of the additional constraints.

An optimal site is identified southwest of Acadia National Park at 43.7°N 68.9°W. This
site has location-dependent costs including WECs and vessel travel of $30.0M and an overall
cost of $56.8M. A breakdown of all cost terms related to this site for a small WPAF with
five cylindrical net pens is presented in table 4. Note that these costs are reported for the
WPAF considering a lifetime of 15 years, and expected annual fish harvest from the farm.

It can be observed that WEC cost will account for more than half of the total cost of the
WPAF, which highlights the importance of finding a location for this system with high wave
power density and therefore a lower number of WECs. Using equation 3 and considering the
total cost and an annual fish yield of 676 tonnes, the levelized cost of fish at the optimal site
is estimated to be $9.23 per kilogram. This unit price is marginally higher (~11%) than the
current market rate which in 2023 placed salmon at $8.28 per kilogram (Statista, 2024).
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Figure 10: Sites that meet requirements of depth, carrying capacity, and lack of conflicts. Colors indicate
the levelized cost of fish, and numbers indicate the cost multiplier relative to the optimal site.

Table 4: Overview of all cost terms for a sample small WPAF with five cylindrical net pens with a diameter
of 30 m, height of 15 m, 15-year lifetime, and an annual fish yield of 676 tonnes at the optimal location of
43.7°N and 68.9°W (WEC cost accounts for CapEx and OpEx terms).

Cost term Value [$ millions] | Share [%]
WEC cost 29.45 51.8
Vessel travel cost 0.59 1.0
Net pen cost 5.30 9.3
Feed barge cost 3.73 6.6
Fish feed cost 12.8 22.5
Fingerling cost 4.94 8.7
Total cost 56.81 100

7. Discussion

Overall trends include a large amount of variation between the costs of each site despite
relative proximity, driven in large part by access to wave resources. The decrease in cost
further offshore demonstrates that location-dependent WPAF costs are dominated by the
WEC cost, as opposed to the vessel travel cost which increases with distance from shore.
The optimal site at 43.7°N 68.9°W, with location-dependent costs of $30.0M is one of the
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Figure 11: Detail of optimal sites and nearby feasible sites. Colors indicate the levelized cost of fish, and
numbers indicate the cost multiplier relative to the optimal site.

furthest feasible sites from shore and has location-dependent costs several times cheaper than
sites closer to land. Closer to shore, the cost increases significantly for sites in sheltered bays
and other areas that would require many more WECs to power even a modest farm. This
trend by far outweighs factors like the increased travel costs for deployment locations further
from shore, although there are certain limits due to increasing depth and other constraints.
The main takeaway from this cost analysis is that it is worthwhile to consider deployment
locations farther offshore to decrease the WPAF cost by decreasing the number of required
WECs. At these locations, the model estimates a levelized cost of fish near current market
rates. Although this may indicate that the model is within the ballpark of actual costs, the
cost model currently lacks enough detail to draw further conclusions or to make comparisons
with market rates. The cost model used in this study does not include all cost components
and instead focuses on those that change with location, such as distance to shore. The result
is a relative, rather than absolute, metric intended to enable a comparison of different sites
within the same study.

The conflict analysis also reveals the difficulty in finding a feasible site for a WPAF,
especially given the number of other oceanic activities and the number of areas that do not
meet the required bathymetry or carrying capacity. The final results end up being further
north than perhaps expected, far away from many of the areas where current activities

19



1.4 100 100
— Pareto front <& All sites

1.2 @ Feasible sites *  Utopia point 9 90
) o
c ‘ —
2 1.0 ° °® 80 80 ¢
S . ) 9
& Optimal feasible @ =
> 0.8 site ©) 70 70 &
< c
= S
> 0.6 1 60 60 &£
= i
© @
041 8 50 |'t50 §
>

0.2 { Overall utopia @ ) 40 40

' @
. * °
¥ N Feasible utopia

20 40 60 80 100
Wave Energy Converter NPV ($ millions)

Figure 12: Results of the vessel travel and WEC cost function for feasible sites (circles), and overall results
regardless of whether they meet the constraints (diamonds). Note that sites with excessive costs ($600M
and above) are not shown on plot.

like fishing and offshore wind development occur. In some cases, changes to the design or
planning process may allow some of these constraints to be relaxed. Carrying capacity, for
example, is the most limiting constraint in this case study and is strongly influenced by net
pen size and fish stocking density. In this case study, these values are taken from current
industrial net pen standards (Innovasea, 2023), but decreasing the size of the net pen or its
stocking density would increase the number of feasible points, albeit at the cost of decreased
yield. Conflicts with certain offshore areas, like military zones, may never be feasible while
others, like wind farms, may allow for co-location in the future as potentially synergistic
relationships are better understood. Future work investigating this synergy could increase
the number of feasible points for the WPAF given the possibility of co-locating the wind
farm and WPAF at the same site.

Existing WPAF studies demonstrate similar methodologies and trends, although it is
difficult to compare results directly given that WPAFs remain a relatively new concept.
A study by Clemente et al. (2023) investigates co-location potential at two sites along the
Portuguese coastline using various farm designs. Although Clemente et al. (2023) do consider
some similar factors including annual wave energy availability, a point absorber WEC as
an energy source, and the feasibility of Atlantic salmon, their analysis is more focused on
changing the design of the farm at a limited number of sites rather than analyzing many
different sites with a single farm design. A study by Garavelli et al. (2022) is more similar
to this study in that it focuses on siting and considers similar geographic factors including
bathymetry, wave height, and marine protected areas. Their analysis yields similar results
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to this study as they identify wave power density, bathymetry, and conflicts (in their case
navigation routes and managed areas) to be key factors in determining favorable locations.
However, they use a binary suitability score rather than a cost model making it difficult to
directly compare the impact of these criteria on site selection.

8. Conclusion

Marine spatial planning is a topic of critical importance given the continued development
of various offshore industries and our increasing reliance on aquatic resources for food and
energy. Careful planning of these resources is necessary to ensure their sustainable use and
avoid conflicts with other existing and future industries that operate along our coastlines.
This paper provided an overview of several MSP techniques using open-source software
including QGIS and Python, alongside the application of those techniques to a case study
in siting a wave-powered aquaculture farm.

The MSP techniques discussed include the process of selecting a scope and preparing data,
analysis options within QGIS of both vector and raster data sets as they relate to marine
energy applications, and the potential to integrate with more complex Python models using
GeoPandas, Rasterio, and a “handler” object made for the model used in the case study.
Using information on the wave climate, biological conditions, and various conflicts, several
feasible sites for a wave-powered aquaculture farm were identified along the coast of Maine.
A cost model was then used to select one optimal location southwest of Acadia National
Park with location-dependent costs of $30.0M for a five-pen farm. The optimal site has a
levelized cost of fish of $9.23 per kilogram, which is on par with current market rates. The
analysis revealed the importance of identifying conflicts in the siting process early on, and
the significance of wave energy availability, and therefore distance to shore, to the cost of a
project.

Future work on the case study of a wave-powered aquaculture farm includes more in-depth
analysis given time series data of conditions and consideration of energy storage within the
WPAF to ensure a reliable power supply. Different layouts, directions, near and far-field
effects, and park effects could also be integrated to provide more detailed modeling of WEC
performance. The cost model could also be improved by adding terms related to the energy
transfer between the WEC and aquaculture farm. An integrated multi-trophic aquaculture
setup will also be considered which allows other species such as kelp and mollusks to grow
alongside fish with the goal of creating mutualistic relationships between the different species.
This could be coupled with an expansion of the carrying capacity model to include aspects
like nutrient use and production in addition to oxygen depletion. Additional environmental
metrics would be useful to integrate as well, including constraints on benthic habitat and
areas with endangered species, and emissions savings over a diesel-powered farm. The MSP
techniques and generated map layers from this study will also be integrated into a more
general web-based mapping tool to make the work more accessible to the many stakeholders
who could benefit from this kind of analysis. Finally, more outreach with stakeholders will be
conducted to receive feedback on the usefulness of the existing analysis and more information
on the issues they face in practice.
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Data Availability

Code required to reproduce the findings in this study is available in the SEA Lab GitHub
at https://github.com/symbiotic-engineering /aquaculture, and the relevant pre-processed
data files are hosted on Zenodo at https://zenodo.org/records/10140826. Raw data files are
publicly available from the sources cited in tables 1 and 2.

Appendix A. QGIS Instructions

This appendix contains a brief overview of specific QGIS instructions for the steps out-
lined in this paper for those interested in following a similar procedure for MSP analysis. The
QGIS Training Manual (https://docs.qgis.org/latest /en/docs/training  manual/index.html)
and associated documentation are also helpful guides which provide more detail and further

instructions. The processes below correspond to and are further explained in sections 4.1,
4.2, and 4.3.

Appendiz A.1. File Conversion

Conversion from an ArcGIS format, is only necessary for certain raster files distributed
in the proprietary GeoDatabase (.gdb) format. Although QGIS can currently access vector
data in these files, rasters must be loaded into ArcGIS and exported as GeoTIFF (.tiff)
files to be readable by QGIS and other applications. This process is straightforward but
unfortunately requires users interested in using data from organizations that publish data in
GeoDatabases to have access to ArcGIS.

Appendiz A.2. Vector interpolation

Certain data sets for environmental conditions are distributed in a vector format with
many points containing measurements instead of as a continuous raster. For many analyses,
having a continuous raster of conditions is beneficial, and interpolation can be used to
approximate this from discrete measurements. In this study, the data used for dissolved
oxygen and salinity are distributed as vector files, but are converted to rasters. From the
processing toolbox (Processing > Toolbox), the TIN Interpolation tool can be used to
convert interpolate a vector data set of point measurements into a continuous raster data set.
TIN Interpolation allows the user to select the desired layer, the attribute that contains
the desired measurement, and a reasonable resolution (as discussed in section 3.1) for the
given study. The resulting raster is limited to the area bounded by the original points, so
r.fill.stats in the processing toolbox can be used to extend the range of the raster and
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smooth the results of the interpolation. The parameters of this operation will vary by the
study scope and individual data set. For this study, each raster is extended past the shoreline
to ensure all coastal waters could be analyzed, then clipped back to include only the study
scope.

Appendiz A.3. Clipping

Data is clipped to only include the scope of designated state and federal waters. This
relies on a vector layer describing the study scope which, in this study, is the file with state
and federal waters from NOAA in table 2. To clip raster layers, click Raster > Extraction
> Clip Raster by Mask Layer... and select the correct vector layer as a mask. For vector
layers, click Vector > Geoprocessing Tools > Clip... and select the same mask as the
overlay layer. Both operations will create a temporary scratch layer of the results, which can
be exported to a permanent file.

Appendiz A.4. Re-projection

GIS data and maps use different projections to translate the three-dimensional globe
into a two-dimensional image. This study uses WGS 84 (EPSG:4326), a very common CRS,
to standardize all downloaded data because of its simplicity, and so that each data set
uses units of degrees in latitude and longitude. WGS 84 / UTM Zone 19 is used for final
maps exported from QGIS, which is tailored for the specific region of the earth included
in the scope and minimizes distortion in that area. Layers can be re-projected during the
export process. Simply right-click and select Export > Save Feature As..., then select
the desired projection (e.g. WGS 84) as the CRS. The CRS for final maps (e.g. WGS 84 /
UTM Zone 19) is set later in the item properties of a map element in a layout, and does not
need to match the CRS of individual layers.

Appendiz A.5. Contour generation

Contours are generated via Raster > Extraction > Contour.... An input layer can
be selected alongside an interval size between each line, which should be picked based on the
range of values in the particular data set. The attribute name, which defaults to ELEV, is the
name of the field in the contour data set with measurement values. After generating contours,
it can be helpful to style them or add labels in Layer Styling > Labels or in some cases
filter out some the contours that are shown on the map. In the case of bathymetry, for
example, the zero-value contour is filtered out along with many of the deeper regions where
contours become more tightly spaced along the continental shelf.

Appendiz A.6. Reclassification

The Raster Calculator (Raster > Raster Calculator...) is useful for a many opera-
tions including reclassification of raster data sets. To reclassify about the mean as in the case
of fishing traffic, identify the mean and standard deviation in the layer properties dialog.
The code below is an example used to reclassify fishing data given a mean of 4.6 vessels and
standard deviation of 23.1.

("2021 All Vessel Activity@i" - 4.6) / 23.1
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This generates a new output layer with fishing data centered around the mean which can
be easily displayed or converted to a vector file as in the case of a conflicts analysis. Raster
Calculator tends to output somewhat messy files, but these problems can be addressed with
some additional clipping and layer styling.

Appendiz A.7. Polygonalization

Raster > Conversion > Polygonize... can be run given the input raster and band
(the component of a layer with a specific measurement) to convert the raster to vector areas.
Depending on the input data file, the resulting vector will likely appear rough and may
contain island-like areas that are too small to be relevant for analysis on a larger scale.
There are several processing tools to improve the generated vector including Delete holes,
which can fill in small areas; Add geometry attributes, which can calculate the area of
each region thus allowing very small regions to be filtered or deleted; and Buffer, which
can be used to expand or contract regions and create a smoother outer edge than what is
generated from the original raster pixels.

Appendiz A.8. Intersection identification

To find the intersection between two vector layers, use Vector > GeoProcessing Tools
> Intersection and select the layers in question. This generates a new layer of the inter-
section which can be stylized to highlight conflicts or other areas of importance.
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